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1.00 2007-06-11 First release Thorbjörn Palm 
1.01 2007-06-20 Minor corrections Thorbjörn Palm 
1.02 2007-06-25 Official release Thorbjörn Palm 
1.03 2008-03-05 Updated layout Thorbjörn Palm 

More information about the network and products 
The latest manuals and EDS-files can be found on the HMS homepage, www.anybus.com 

The DeviceNet user organisation has a homepage on the Internet, www.odva.org. Several technical guides 
are available in or via this page. 
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1  Applicable Anybus products 
Description Name / Type 

Anybus X-gateway  DeviceNet 

Anybus Communicator  DeviceNet 

Anybus-Slave  DeviceNet 

Anybus-CompactCom DeviceNet 

Anybus-IC DeviceNet 

Anybus -PCI DeviceNet 
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2 Requirements 
Description Name / Type Version 

Rockwell PLC  Allen Bradley ControlLogix 
5000 with 1756-DNB 
DeviceNet Scanner card, 

n.a. 

PLC software RSNetWorx for DeviceNet 1.21 

Rockwell communication software RSLinx 2.41 

EDS-file for the Anybus-S DeviceNet interface and 
the Anybus X-gateway DeviceNet adapter 

EDS file for the Anybus Communicator DeviceNet 

EDS file for the Anybus CompactCom DeviceNet 

EDS_ABS_DEV_V_1_35.eds 
 

EDS_ABC_DEV_V_1_10.eds 

EDS_ABCC_DEV_V_2_1.eds 

1.35 
  

1.10 

2.1 

X-gateway Network Interface Addendum Anybus X-gateway-DeviceNet 
Adapter Interface, Network 
Interface Addendum  

1.00 

X-gateway User Manual X-gateway Generic , User 
Manual 

1.02 

Communicator User Manual Anybus Communicator for 
DeviceNet, User Manual 

2.50 

Adapter Fieldbus Appendix Anybus-S DeviceNet, Fieldbus 
Appendix 

2.06 

IC Fieldbus Appendix Anybus-IC DeviceNet, 
Fieldbus Appendix 

1.51 

PCI Interface Design Guide Anybus-S Slave & Master, 
Parallel Interface Design 
Guide 

2.0 

Power supply 24VDC n.a. n.a 

Configuration cables n.a. n.a. 

Null modem cable (Supplied with the Anybus X-
gateway) 

n.a. n.a. 

Note: The EDS files can be downloaded at the website www.anybus.com. 

http://www.anybus.com/
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3 Solution overview 
This application note describes how to configure an Anybus product with a Rockwell PLC. Below you can 
find an overview of the system described in this document. Other nodes may be attached to the network, but 
are not necessary. 

Note: This document is valid for all Anybus DeviceNet slave/adapter products, however sections written in 
italics describe the configuration of a specific product. 

• Anybus CompactCom for DeviceNet 

• Anybus Communicator for DeviceNet 

• Anybus X-gateway DeviceNet 

• Anybus-IC DeviceNet Adapter Interface 

• Anybus-PCI DeviceNet Adapter Interface  

• Anybus-S DeviceNet Adapter Interface  

The contents describe step by step how a configuration is done. This document assumes the reader is familiar 
with industrial communication, DeviceNet networks and HMS Communicator and X-gateway. 
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Figure 1 Hardware connection overview. 
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3.1 Hardware Settings 
The selected baud rate of the PLC and the Anybus product is to be set to the same rate. Also make sure the 
MAC ID of the adapter and the scanner is not the same.  
 
Note for X-gateway and Communicator: 
The switches will be found next to the power connection on the X-gateway and next to the indication LEDs 
on the Communicator. DIP switches 1-2 set the Baud Rate and DIP switches 3-8 set the MAC ID. For further 
instructions see the Anybus Communicator User Manual, X-gateway Manual Addendum or the Adapter 
Fieldbus Appendix. 
 
Note for the Anybus-IC: 
For the Anybus –IC for DeviceNet the configuration is depending on the application. The MAC ID and baud 
rate is set by the application process or by switches if mounted.  
 
Note for the Anybus-PCI: 
The DeviceNet Adapter PCI card is configured by mailbox commands; refer to the Adapter Fieldbus 
Appendix.  
 
Note for the Anybus CompactCom and the scanner module: 
The scanner module used by the PLC and the Anybus CompactCom can be configured by the RSNetWorx for 
DeviceNet software. Open the Tools menu and select node commissioning. The following window will  
be visible. 

 
Figure 2 The node commissioning tool in RSNetworx. 

Click on the browse button and select the desired module as shown above. 
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Figure 3 Browsing the network. 

The final step is to select the desired baud rate and click on apply as shown in the previous picture. 
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4 DeviceNet configuration 
RSNetworx for DeviceNet is the tool used to configure the DeviceNet scanner. There are two ways to 
configure the network. It is possible to configure the network in offline or online mode. It is recommended to 
start with online mode and to manually complement with the modules not recognised by the RSNetworx for 
DeviceNet.  

 
Figure 4 The driver dialogue. 

4.1 Online mode 
Start the program RSNetworx for DeviceNet. Verify that the EDS file for the Anybus product has been 
installed. This can be done by browsing the library in the left window. The EDS file for the Anybus products 
can be downloaded at HMS website1. If the Anybus EDS-file has not been installed click on the Tools menu 
and then on EDS wizard to import the EDS file. Click on next and the following window will appear. 

 
Figure 5 The EDS wizard. 

                                        
1 www.anybus.com 
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Select register an EDS file and select next. Follow the dialogue as shown below. 

 
Figure 6 Browsing the EDS file. 

The next step is to scan the network for any attached nodes that can be added to the Scanner’s scan list. From 
the Network menu select Online or click on the online button as shown in the figure below. This will scan 
the entire network at the Baud Rate set up in the scanner and any attached nodes will be listed. You will end 
up with a diagram of all connected devices as indicated in the figure below. 

 

Online button 

Figure 7 Online network. 
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4.2 Offline mode 
The other way to configure the DeviceNet network is in offline mode. For devices not included in the library 
of the RSNetWorx for DeviceNet an EDS file has to be imported as described in the previous chapter. If the 
module is not included in the library the unit will not be recognised by the program. Make sure the program 
is in offline mode. To build the network, as shown in figure 7 showing the online network, use the navigation 
list to the left and use drag and drop. 

4.3 Scanner configuration 
The next step is to configure the Scanner. Double-click on the 1756-DNB/A icon. This will bring up a 
window with the Scanner’s configuration. 
 
Select the Scan list Tab as shown below, you will be prompted whether to download the offline 
configuration to the Scanner or upload the Scanner’s current configuration. Choose upload. After uploading 
you will have a graphic showing the list of available devices to be added and a list of devices already loaded 
in the scanner as shown in the figure below. 

 
Figure 8 Scanner configuration. 

To add devices to the scan list, the Communicator in this case, highlight the Communicator in the list of 
available devices and click on the right-hand arrow to add to the scan list. The Communicator has now been 
added and the I/O size needs to be configured. 
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4.4 Configuring the I/O size and Mapping 
From the Scan list window, select Edit I/O Parameters. A window will appear for configuring the I/O type 
and size. In this example Polled is selected for the I/O type and the size for Inputs and Outputs is based on 
the data returned by the serial application. The figure below gives an example. 

 

Note: The I/O sizes for your 
application will not be 48 bytes IN and 
1 bytes OUT. The figure is just 
showing an example. Also remark the 
Anybus product has to be configured 
for the same I/O sizes. 

Figure 9 Configuring the I/O size. 

After setting the I/O size and selecting OK, you will get a warning message as shown in the figure below. 
This means that the I/O size configured is different than what is designated in the EDS file of the device. In 
the case of the Communicator whose I/O size will depend on the amount of data transmitted by the serial 
interface, this warning should be ignored and the values accepted if correct. 

 
Figure 10 Scanner configuration warning. 

Next step is to verify the I/O mapping. Data is normally auto-mapped into continuous 32-bit registers in the 
ControlLogix designated memory for the 1756-DNB module. To verify the Input, select the tab Input in the 
Scanner’s configuration window. You will get a window as shown in the figure below. Verify that this is the 
correct memory mapping to be used by the PLC program. 
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Figure 11 Verifying the Input mapping. 

Verify the mapping of the Output by selecting the tab Output in the scanner’s configuration window. The 
figure below gives an example of mapping. 

 
Figure 12 Verifying the Output mapping. 

Once the mapping has been verified and the I/O sizes set, the configuration needs to be downloaded to the 
scanner. Return to the Scan list tab in the scanner’s configuration window and select Download to Scanner. 
This will save the configuration to the scanner. Once the scanner is in Run mode, data should be exchanged. 
To be in run mode the run bit has to be set, see the chapter on DeviceNet run mode. 
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4.5 DeviceNet run mode 
When using a PLC as a scanner the run bit has to be set, otherwise the DeviceNet Scanner card will remain 
in idle mode. This can be done in the PLC program by adding an output on the first rung assigned 
“Local:1:O.CommandRegister.Run”. The picture below shows this in ladder format. 

 
Figure 13 Setting the run bit for the 1756-DNB card in ladder format. 

Note for X-gateway:  
When using an X-gateway as a scanner the status bit for run mode has to be set, otherwise the module will 
remain in idle mode. This can for example be done from a PLC program.  
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5 Anybus configuration 
The Anybus product has to be configured for the same I/O sizes as set up in the DeviceNet scanner 
configuration. 

Note: The I/O sizes are depending on the application, the configured I/O sizes in this chapter are just 
examples.  

Anybus Slave Interface and the Anybus PCI card 

The Anybus Slave Interface and the Anybus PCI card are configured by mailbox commands. Refer to 
respective Fieldbus Appendix for details. 

Anybus-IC 

The Anybus-IC is configured by the User Interface using for example the Windows Hyper Terminal. Refer to 
the Design Guide for details. 

Anybus CompactCom 

The Anybus CompactCom is configured by messages send by the application. Refer to the Design Appendix 
for details. 

Anybus Communicator and the Anybus X-gateway 

The configuration of the Anybus Communicator and the Anybus X-gateway is described in separate sections 
below. 
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5.1 Communicator configuration 
To configure the Communicator, start the ABC Config Tool, select the fieldbus DeviceNet and the desired 
I/O data. If explicit data is used the I/O sizes has to be set to user defined mode, otherwise automatic can be 
used. For a more detailed description see the Communicator User Manual. 

 
Figure 14 Configuring the Communicator 

5.2 X-gateway configuration 
Use the HyperTerminal on a PC and configure the X-gateway, connect a serial cable between the PC and 
the config port on the X-gateway. Open the “File” menu and click on new, choose the desired COM port and 
click OK. The following window will appear.  

 
Figure 15 Configuring the connection in the HyperTerminal. 

Make sure the settings are identical to those shown in the window above. An alternative method is to 
download the HyperTerminal session file from HMS website, double click on it and select COM port. 

Connect and press ESC and the following menu will appear. 
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Figure 16 Anybus X-gateway Main menu. 

Press 6 and enter the desired configuration. The figure below shows an example; in this case a 
DeviceNet/Ethernet ModbusTCP X-gateway is used and 20 bytes of I/O data is configured. 

 
Figure 17 The X-gateway configuration.  

The explicit data is used for acyclic parameter data. The parameter data is sent by request of the scanner 
while the I/O data is sent on a cyclic basis. For a more detailed description see the X-gateway DeviceNet 
Adapter Interface, Network Interface Addendum. 
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